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RX Family 
RX Driver Package Ver.1.13  

Introduction 
This document is the RX Family RX Driver Package User’s Manual, version 1.13. 

This User’s Manual describes basic structures, features and usage of RX Driver Package applications, and about the 
sample application program using the FIT modules included in this package. 

Note that older versions of the RX Driver Package can be obtained by clicking the “Sample Code” link after accessing 
the following URL. 

RX Driver Package webpage: https://www.renesas.com/rdp 

 

Target Devices  
RX110, RX111, RX113, RX130 Group  

RX210, RX230, RX231, RX23T, RX24T, RX24U Group 

RX63N, RX64M, RX65N, RX651 Group 

RX71M Group 

For Evaluation board, Renesas Starter Kit is used.  

 

When using this application note with your product, careful evaluation is recommended. 

And when using this application note with other Renesas MCUs, careful evaluation is recommended after making 
modifications to comply with the alternate MCU. 

  
Version of e² studio Used for Operation Confirmation 
Operation of the RX Driver Package has been confirmed on e2 studio V.6.0.0.  

The RX Driver Package can be obtained from within e2 studio. Instructions are provided in section 4, Usage. 

Related Documents 
• RX Family  Board Support Package Module Using Firmware Integration Technology (R01AN1685EJ) 
• Firmware Integration Technology User’s Manual (R01AN1833EU) 
• RX Family  Adding Firmware Integration Technology Modules to Projects (R01AN1723EU) 
• RX Family  Adding Firmware Integration Technology Modules to CS+ Projects (R01AN1826EJ) 
• The User’s Manual provided with the RX Driver Package Application. 
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1. Overview 

1.1 Applicability 
This User’s Manual applies to the RX Family RX Driver Package, version 1.13. 

 

1.2 Operating Environment 
This package runs under the operating environment described below. 

 
Table 1-1   Operating Environment 

Item Contents 
Integrated development 
environment 

Renesas Electronics e2 studio V6.0.0 

C compiler Renesas Electronics C/C++ compiler for RX Family V.2.07.00 
Compiler options: The integrated development environment default settings 
are used, with the following option added. 
-lang = c99 

Endian order Big-endian/Little-endian 
RDP version Ver. 1.13 
Board used Renesas Starter Kit for RX64M (product No.: R0K50564MSxxxBE) 

Renesas Starter Kit for RX231 (product No.: R0K505231SxxxBE) 
Renesas Starter Kit for RX130-512KB (product No.: RTK5051308SxxxxxBE) 
Renesas Starter Kit for RX65N-2MB (product No.: RTK50565N2SxxxxxBE) 
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2. About RX Driver Package 
The RX Driver Package is a software platform (framework) that combines the following modules to be required for 
development in a single package. Since the package contains multiple modules, you can start developing immediately 
without having to obtain each module separately. 

Board Support Package (BSP) module 

FIT peripheral function modules (free version)  

FIT middleware modules (free version) 

FIT interface modules  

 

You can develop the user application layer with ease by using the Sample Application Program (RX Driver Package 
Application) which utilizes the RX Driver Package. 

2.1 System Structure 
The figure below shows the system structure of the RX Driver Package. 

 

 

Figure 2-1   System Structure 
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2.2 RX Driver Package Features 
The RX Driver Package has the following features. 
 
(a) Select Necessary Modules and Start Developing Immediately the Application Program 
You can easily build a system simply by selecting the modules you need from the package. After that, all you have to 
do is develop the application program. 

 

 

Figure 2-2   An Example of System Build 
 

(b) Free to Use 
All the modules included in the RX Driver Package can be used free of charge. Free versions of middleware modules 
such as TCP/IP and file system are included. 

 

(c) Can Upgrade to Paid Versions of Modules 
The free versions of modules in the RX Driver Package can be replaced with commercial (paid) versions. By using a 
commercial (paid) version, all the functionality of the module will be available, as well as support about a commercial 
version. 

For commercial version (paid) modules, see 6.1 for separate purchase. 

 

(d) Check Operation Including User Application 
The RX Driver Package Application is provided as a sample user application that uses the RX Driver Package. The RX 
Driver Package Application consists of programs for operating each module in the RX Driver Package, and the project 
files for building the programs. It enables you to start checking the operation of your user application immediately. 
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3. Structure of the RX Family RX Driver Package 

3.1 Folder Structure 
The folder structure used in this package is shown below. 

When the ZIP file for this package is downloaded from the Renesas web site and decompressed, a folder of the same 
name will be present and it will contain a FITModules folder, a reference_documents folder, and this document. 

The FITModules folder contains the Firmware Integration Technology (FIT) modules shown in Table 3-1, Table 3-2, 
Table 3-3 (as ZIP files and XML files). For the FIT module supporting pin setting function, MDF file is contained. 

The reference_documents folder contains the documentation for using this package in various development  

 

Figure 3-1   Folder Structure of the RX Family RX Driver Package 
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3.2 FIT Modules 
The table below lists the FIT modules included in this package. 

After the release of RX Family RX Driver Package Ver.1.12 (R01AN3651), many Firmware Integration Technology 
(FIT) modules have been updated. Differences from Family RX Driver Package Ver.1.12 are shown in Table 3-1, Table 
3-2 and Table 3-3.  

The meaning of the terms shown in differences columns are as follows:  

“Same” Includes the same module as previous.  
“Updated” Includes updated modules.  

Updated contents differ depending on the driver used. Check with the driver’s 
document.  

“Added” Includes the added modules this time.  
 

(1) Board Support Package (BSP) 
Table 3-1   Board Support Package (BSP) 

Module  FIT Module Name Rev Update 
Information 

Board Support Package (BSP) r_bsp 3.60 Updated 
 

(2) Device Driver 
Table 3-2   Device Driver 

Module  FIT Module Name Rev Update 
Information 

Voltage Detection Circuit (LVD) r_lvd_rx 2.30 Updated 
Low Power Consumption (LPC) r_lpc_rx 1.40 Same 
Battery Backup (VBATT) r_vbatt_rx 1.01 Same 
Interrupt Controller (IRQ)  r_irq_rx 2.20 Updated 
Data Transfer Controller (DTC) r_dtc_rx 2.08 Updated 
DMA Controller (DMAC) r_dmaca_rx 1.05 Updated 
I/O Ports (GPIO) r_gpio_rx 2.30 Updated 
Multi-Function Pin Controller (MPC)  r_mpc_rx 2.30 Updated 
Compare Match Timer (CMT) r_cmt_rx 3.20 Updated 
Compare Match Timer W (CMTW) r_cmtw_rx 1.30 Updated 
Real-Time Clock (RTC) r_rtc_rx 2.71 Updated 
Low Power Timer (LPT) r_lpt_rx 1.20 Updated 
Independent Watchdog Timer (IWDT) r_iwdt_rx 1.80 Updated 
Watchdog Timer (WDT) r_wdt_rx 1.10 Updated 
Serial Communications Interface (SCI: Asynchronous/Clock 
Synchronous) 

r_sci_rx 2.00 Updated 

Serial Communications Interface with FIFO (SCI: Asynchronous/Clock 
Synchronous) 

r_scif_rx 1.20 Added 

Serial Communications Interface with FIFO (SCIF: Device Driver for 
Serial Memory Control) 

r_scifa_smstr_rx 1.09 Same 

Serial Communications Interface (SCI: Simple I2C Bus) r_sci_iic_rx 2.20 Updated 
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I²C Bus Interface (RIIC) r_riic_rx 2.20 Updated 
Serial Peripheral Interface r_rspi_rx 1.70 Updated 
Serial Peripheral Interface (RSPI: Device Driver for Serial Memory Control) r_rspi_smstr_rx 1.14 Updated 
Quad Serial Peripheral Interface (QSPI: Device Driver for Serial Memory 
Control) 

r_qspi_smstr_rx 1.10 Updated 

USB Basic Firmware r_usb_basic 1.22 Updated 
USB Host Mass Storage Class r_usb_hmsc 1.22 Updated 
USB Host Communication Device Class r_usb_hcdc 1.22 Updated 
USB Host Human Interface Device Class r_usb_hhid 1.22 Updated 
USB Peripheral Mass Storage Class r_usb_pmsc 1.22 Updated 
USB Peripheral Communications Device Class r_usb_pcdc 1.22 Updated 
USB Peripheral Human Interface Device Class r_usb_phid 1.22 Updated 
USB Basic Firmware mini r_usb_basic_mini 1.02 Updated 
USB Host Mass Storage Class mini r_usb_hmsc_mini 1.02 Updated 
USB Host Communication Device Class mini r_usb_hcdc_mini 1.02 Updated 
USB Host Human Interface Device Class mini r_usb_hhid_mini 1.02 Updated 
USB Peripheral Mass Storage Class mini r_usb_pmsc_mini 1.02 Updated 
USB Peripheral Communications Device Class mini r_usb_pcdc_mini 1.02 Updated 
USB Peripheral Human Interface Device Class mini r_usb_phid_mini 1.02 Updated 
PTP Module for the Ethernet Controller (EPTPC)  r_ptp_rx 1.14 Updated 
EPTPC Light Module r_ptp_light_rx 1.11 Same 
Ethernet controller (ETHERC) r_ether_rx 1.13 Updated 
CAN Module (CAN) r_can_rx 2.12 Updated 
CAN Module (RSCAN) r_rscan_rx 1.10 Same 
IrDA Interface (IrDA) r_irda_sci_rx 1.10 Same 
Parallel Data Capture Unit (PDC) r_pdc_rx 2.01 Updated 
SD Host Interface (SDHI) r_sdhi_rx 2.00 Added 
SD Slave Interface (SDSI) r_sdsi_rx 2.00 Added 
12-Bit A/D Converter (S12AD) r_s12ad_rx 2.30 Updated 
D/A Converter (DAC) r_dac_rx 3.10 Updated 
Flash Memory (On-chip flash memory Programing) r_flash_rx 3.20 Updated 
Sampling Rate Converter (SRC) r_src_api_rx 1.11 Same 
Serial Sound Interface (SSI) r_ssi_api_rx 1.21 Updated 
LCD Controller/Driver (LCDC) r_lcdc_rx 1.00 Same 
Graphic LCD Controller (GLCDC) r_glcdc_rx 1.00 Added 
Unique ID Read r_uid_rx 1.00 Same 
Byte Queue Buffer (Data Management) r_byteq 1.60 Same 
Long Queue Buffer (Data Management) r_longq 1.60 Same 
Event Link Controller (ELC) r_elc_rx 1.20 Updated 
 

 



RX Family RX Driver Package Ver.1.13 

R01AN3859EJ0113  Rev.1.13  Page 9 of 57 

Oct 20, 2017  

(3) Middleware/Interface Module 
 

Table 3-3   Middleware/Interface Module 

Module  FIT Module Name Rev Update 
Information 

TCP/IP M3S-T4-Tiny for Embedding r_t4_rx 2.06 Same 
Interface conversion module for Ethernet Driver and Embedded system 
M3S-T4-Tiny 

r_t4_driver_rx 1.06 Same 

System Timer Module r_sys_time_rx 1.00 Same 
SPI Serial EEPROM Module r_eeprom_spi 2.34 Updated 
SPI Serial Flash memory Module r_flash_spi 2.34 Updated 
I2C Bus Interface (RIIC) Module for EEPROM Access r_eeprom_riic_rx 1.40 Same 
Simple I2C Module for EEPROM Access r_eeprom_sci_iic_rx 1.30 Same 
JPEG Decoder Module r_jpegd_rx 2.06 Same 
JPEG Encoder Module r_jpege_rx 1.01 Same 
Sound playback system and compression system (original ADPCM 
codec) 

r_s2_rx 3.04 Same 

M3S-TFAT-Tiny (FAT file system) r_tfat_rx 3.03 Same 
M3S-TFAT-Tiny Memory Driver Interface Module r_tfat_driver_rx 1.03 Same 
Note: This package includes the M3S-T4-Tiny (TCP/IP protocol stack library) of evaluation version. For the commercial 

version, please go to the below URL. 
https://www.renesas.com/mw/t4 

https://www.renesas.com/mw/t4
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4. Usage 
You can easily construct application programs incorporating the RX Driver Package by using the Smart Configurator or 
FIT Configurator function of e2 studio.  

For instructions on using the RX Driver Package with CS+, refer to RX Family: Adding Firmware Integration 
Technology Modules to CS+ Projects (R01AN1826EJ), which is included in the RX Driver Package. 

This section describes how to download the RX Driver Package and create a program for illuminating LEDs. You will 
need to log into My Renesas as part of the procedure.  

 

4.1 Adding FIT Modules to Your Project 
The procedure for using the functions of e2 studio to download the RX Driver Package and develop an application 
program are described below. 

Different procedures are used for downloading the RX Driver Package and adding it to an application program using 
the Smart Configurator and FIT Configurator functions, respectively. The description is therefore divided into two 
parts: 4.1.1 describes how to download the RX Driver Package with Smart Configurator, and 4.1.2 describes how to 
download the RX Driver Package with FIT Configurator. 
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4.1.1 Smart Configurator 
How to create a new workspace and download the RX Driver Package is described below. 

In this example, “RX65N” is used as the target MCU and “Renesas Starter Kit+ RX65N-2MB” as the target board. If 
the environment to be used for the download is different, adjust the relevant parts of the description that follows to 
match the actual environment. 

 

(1) Creating a New Workspace and Project 

In order to download the RX Driver Package, you must create a new workspace and project. 

 

(a) Launching e2 studio 

From the Windows Start menu, launch e2 studio. 

 

(b) Designating the Workspace 

The Select a directory as workspace dialog box appears. 

1. Enter the name of the workspace folder of your choice in the Workspace field. 

2. Click the OK button. 

 
Figure 4-1 Designating the Workspace 

  

1.Enter a workspace folder. 

2.Click OK. 
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(c) Opening Workbench 

The Welcome to e2 studio window appears. 

Click the Workbench icon in the top right corner of the Welcome tab. 

 
Figure 4-2 Opening Workbench 

  

Click Workbench. 
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(d) Creating a C/C++ Project 

Workbench starts. 

From the menu bar, select File > New > C/C++ Project. 

 
Figure 4-3 Creating a C/C++ Project 

  

Click here 
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(e) Selecting a Project Template 

The Templates for New C/C++ Project dialog box appears. 

1. Select Renesas RX on the left side of the dialog box.  

2. Select Renesas CC-RX C/C++ Executable Project on the right side of the dialog box. 

3. Click the Next button. 

 
Figure 4-4 Selecting a Project Template 

  

3.Click here. 

1.Click here 

2.Click here. 
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(f) Entering a Project Name 

The Renesas CC-RX Executable Project dialog box appears. 

1. Enter the name of the project into the Project name: field. 

2. Click the Next button. 

 
Figure 4-5 Entering a Project Name 

 

1.Enter the project name. 

2.Click here. 



RX Family RX Driver Package Ver.1.13 

R01AN3859EJ0113  Rev.1.13  Page 16 of 57 

Oct 20, 2017  

(g) Selecting a Toolchain and Device 

The Select toolchain, device & debug settings dialog box appears, allowing you to specify the toolchain, device, and 
debug settings. 

1. From the Toolchain: dropdown list, select Renesas CCRX.*1 

2. From the Toolchain Version: dropdown list, select v2.07.00.*1 

3. Click the … button next to the Target Device: field, and select R5F565NEDxFC.*1 

4. Click the Next button. 

 
Figure 4-6 Selecting a Toolchain and Device 

 

Note 1. If necessary, modify these settings to match your environment. 
 

1.Select a Toolchain. 

3.Select ”R5F565NEDxFC” 
from target device. 

4.Click here. 

2.Select a Toolchain Version. 
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(h) Finishing Creation of a Workspace and Project 

The Select Coding Assistant settings dialog box appears. 

1. Check the box next to Smart Configurator. 

2. Click the Finish button. The project is created. 

 
Figure 4-7 Finishing Creation of a Workspace and Project 

 

1.Check the box. 
 

2.Click here. 
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(2) Downloading the RX Driver Package 

Using the newly created workspace and project, you will download the RX Driver Package. 

 

(a) Adding Components 

The initial screen of Smart Configurator appears. 

1. In the led_sample.scfg tab, select the Components tab. 

2. The Software component configuration dialog box appears. Click the Add component button. 

 
Figure 4-8 Adding Components 

 
 

1.Select a Component. 

2.Click here. 
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(b) Selecting Components 

The Software Component Selection dialog box appears. 

Click Download more software components. 

 
Figure 4-9 Selecting Components 

 

Click here. 
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(c) Selecting a Module to Download 

The FIT Module Download dialog box appears. 

1. Check the box next to the RX Driver Package in order to download it. 

2. Specify the FIT module location in the FIT Module Folder Path: field.*1 

3. Click the Download button. 

 
Figure 4-10 Selecting a Module to Download 

 

Note 1.  Specifying FIT Module Folder Path: 
The downloaded RX Driver Package will be stored in the location specified in FIT Module Folder Path:. 
Any folder may be specified. The default setting is the FITModules folder (usually 
C:\Renesas\e2_studio\FITModules). 

 

1.Check the box. 

2.Set here. 

3.Click here. 
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(d) Logging into My Renesas  

The My Renesas dialog box appears. 

1. Enter your My Renesas email address and password.*1*2 

2. Click the OK button. 

 
Figure 4-11 User authentication 

 

Note 1.  It is necessary to first register as a member of My Renesas on the official Renesas website. Refer to Website 
and Support for details. 

Note 2.  Once you have entered this information, the dialog box no longer appears.  
 

(e) License Agreement 

The End User License Agreement dialog box appears. 

After reading and agreeing to the content of the agreement, click the Agree button. 

 
Figure 4-12 License Agreement 

 

1.Enter email address and password. 

2.Click here. 

Click here. 
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(f) Finishing the Download 

The Download FIT Module dialog box appears. 

Click the OK button. 
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(3) Installing FIT Modules 

After creating a project, you can use Smart Configurator to install the necessary FIT modules.  

In this example, we will install the CMT FIT module (r_cmt_rx). 

 

(a) Opening the Component Preferences Dialog Box 

The Software Component Selection dialog box appears. 

Click Configure general settings... to open the component preferences dialog box.  

 
Figure 4-13 Opening the Component Preferences Dialog Box 

Click here. 
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(b) Displaying All FIT Modules 

The component preferences dialog box appears. 

1. Under Blocked list settings, check the box next to Allow blocked FIT modules to be displayed. 

2. Click the OK button. 

 
Figure 4-14 Displaying All FIT Modules 

 

1.Check the box. 

2.Click here. 
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(c) Select r_cmt_rx 

The Software Component Selection dialog box appears. 

Components downloaded in the procedure of "4.1.1(2)" are displayed as "FIT" type. 

Please select r_cmt_rx in the following procedure. 

1. Select r_cmt_rx from the list of components.*1 

2. Click the Finish button. 

 
Figure 4-15 Adding r_cmt_rx to the Available Components 

 

  

1.Select the r_cmt_tx 

2.Click here. 
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Note 1. Software component list items 
a.Components 

Multiple components are listed, such as “DMA controller” and “interrupt controller.”  
b.Type 

There are two types, “code generation” and “FIT.” Components can conform to any of the following three 
patterns: 

• Code generation-only components 
• FIT-only components 
• Code generation and FIT components 

When specifying components, select the type that matches your requirements. 
c.Version 

The component version numbers are listed. Make sure to select the version that matches your requirements. 
 

 

  



RX Family RX Driver Package Ver.1.13 

R01AN3859EJ0113  Rev.1.13  Page 27 of 57 

Oct 20, 2017  

(d) Generating Code 
The Software component configuration dialog box reappears. 

1. Confirm that r_cmt_rx has been added as a component. 

2. Click the Generate Code button. 

 
Figure 4-16 Generating Code 

 
 

If you use the Smart Configurator to install the FIT module skip the “4.1.2 FIT Configurator”. 

Proceed to “4.2 Create an LED Driving Program”. 

 

  

1.Plese check that 
r_cmt_rx has been added. 

2.Click here. 
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4.1.2 FIT Configurator 
How to create a new workspace and download the RX Driver Package is described below. 

In this example, “RX111” is used as the target MCU and “Renesas Starter Kit+ RX111” as the target board. If the 
environment to be used for the download is different, adjust the relevant parts of the description that follows to match 
the actual environment. 

 

(1) Creating a New Workspace and Project 

In order to download the RX Driver Package, you must create a new workspace and project. 

 

(a) Launching e2 studio 

From the Windows Start menu, launch e2 studio. 

 

(b) Designating the Workspace 

The Select a directory as workspace dialog box appears. 

1. Enter the name of the workspace folder of your choice in the Workspace field. 

2. Click the OK button. 

 
Figure 4-17 Designating the Workspace 

 
  

1.Enter a workspace folder. 

2.Click OK. 
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(c) Opening Workbench 

The Welcome to e2 studio window appears. 

Click the Workbench icon in the top right corner of the Welcome tab. 

 
Figure 4-18 Start workbench 

  

Click Workbench. 
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(d) Creating a C/C++ Project 

Workbench starts. 

From the menu bar, select File > New > C/C++ Project. 

 
Figure 4-19 Creating a C/C++ Project 

 

Click here 
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(e) Selecting a Project Template 

The Templates for New C/C++ Project dialog box appears. 

1. Select Renesas RX on the left side of the dialog box.  

2. Select Renesas CC-RX C/C++ Executable Project on the right side of the dialog box. 

3. Click the Next button. 

 
Figure 4-20 Selecting a Project Template 

 

1.Click here. 

2.Click here. 

3.Click here. 
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(f) Entering a Project Name 

The New Renesas CC-RX Executable Project dialog box appears. 

1. Enter the name of the project into the Project name: field. 

2. Click the Next button. 

 
Figure 4-21 Entering a Project Name 

 

1.Enter the project name. 

2.Click here. 
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(g) Selecting a Toolchain and Device 

The Select toolchain, device & debug settings dialog box appears, allowing you to specify the toolchain, device, and 
debug settings. 

1. From the Toolchain: dropdown list, select Renesas CCRX.*1 

2. From the Toolchain Version: dropdown list, select v2.07.00.*1 

3. Click the ... button next to the Target Device: field, and select R5F51115AxFM.*1 

4. Click the Next button. 

 
Figure 4-22 Selecting a Toolchain and Device 

 

Note 1.  If necessary, modify these settings to match your environment. 
 

1.Select a Toolchain. 

2.Select a Toolchain Version. 

3.Select ”R5F51115AxFM” 
from target device. 

4.Click here. 
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(h) Selecting Coding Assistant Settings 

The Select Coding Assistant settings dialog box appears. 

1. Check the box next to Use FIT Module. 

2. Click the Download FIT Modules button. The FIT Module Download dialog box appears. 

 
Figure 4-23 Selecting Coding Assistant Settings 

 
 

 

 

2.Click here. 

 

1.Check the box. 
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(2) Downloading the RX Driver Package 

Using the newly created workspace and project, you will download the RX Driver Package. 

 

(a) Selecting a Module to Download 

The FIT Module Download dialog box appears. 

1. Under Filtered: check the box next to Show RX Driver Package only. 

2. Check the box next to the RX Driver Package in order to download it. 

3. Specify the FIT module location in the FIT Module Folder Path: field.*1 

4. Click the Download button. 

 
Figure 4-24 Selecting a Module to Download 

 

Note 1.  Specifying FIT Module Folder Path: 
The downloaded RX Driver Package will be stored in the location specified in FIT Module Folder Path:. 
Any folder may be specified. The default setting is the FITModules folder (usually 
C:\Renesas\e2_studio\FITModules). 
The FITModules folder is created automatically when you click the Download FIT Modules button as 
described in 4.1.2(1)(g). 

 

  

1.Check the box. 

 

2.Check the box. 

3.Set here. 

4.Click here. 
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(b) Logging into My Renesas  

The My Renesas dialog box appears. 

1. Enter your My Renesas email address and password.*1*2 

2. Click the OK button. 

 
Figure 4-25 User Authentication 

 

Note 1.  It is necessary to first register as a member of My Renesas on the official Renesas website. Refer to Website 
and Support for details. 

Note 2.  Once you have entered this information, the dialog box no longer appears.  
 

(c) License Agreement 

The End User License Agreement dialog box appears. 

After reading and agreeing to the content of the agreement, click the Agree button. 

 
Figure 4-26 License Agreement 

 

2.Click here. 

1.Enter email address and password. 

Click here. 
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(d) Finishing the Download 

The Download FIT Module dialog box appears. 

Click the OK button. 

 

 
Figure 4-27 Finishing the Download 

 

(e) Finishing Creation of a Workspace and Project 

The Select Coding Assistant settings dialog box appears. 

1. Confirm that the box next to Use FIT Module is checked. 

2. Click the Finish button. The project is created. 

 
Figure 4-28 Finishing Creation of a Workspace and Project 

Click here. 

2.Click here. 

1.Make sure that it is checked. 
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(3) Installing FIT Modules 

After creating a project, you can use FIT Configurator to install the necessary FIT modules.  

In this example, we will install the CMT FIT module (r_cmt_rx). 

 

(a) Opening FIT Configurator 

From the e2 studio menu, select Renesas Views > e2 solution toolkit > FIT Configurator. 

 
Figure 4-29 Opening FIT Configurator 

Click here. 
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(b) Adding Modules 

FIT Configurator is displayed in the lower right of the workspace window. 

1. Open the FIT Configurator tab. 

2. From the Name of the project to add FIT modules: dropdown list, select the newly created project led_sample. 

3. From the Target Board: dropdown list, select RSKRX111. 

4. From the Available Modules list, select r_cmt_rx. 

5. Click the Add Module >> button. 

 
Figure 4-30 Adding Modules 

 
  

2.Select the project. 

3.Select the target board. 

4.Select this FIT module. 

1.Open. 

5.Click here. 
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(c) Generating Code 

The module added by following the steps in Adding Modules appears in the Selected Modules list. 

1. Confirm that both r_bsp and r_cmt_rx appear in the Selected Modules*1 list. 

2. Click the Generate Code button. 

 
Figure 4-31 Generating Code 

  

1.Check these. 

2.Click here. 
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Note 1. Supplementary 
The mark  may appear in “Selected Modules”. It shows that the Warning has occurred in the added FIT 
module. 
The contents of the Warning can be checked from “Console” tab. The occurrence of Warning is caused mainly 
by version mismatch of “r_bsp” that has dependencies with FIT module, and it occurs when the dependent 
information of the FIT module is not updated for the commonly updated “r_bsp”. The Warning can be ignored, 
as the updated “r_bsp” has backward compatibility.  

 
Figure 4-32 Supplementary: Selected Modules List 

 

Example of CMT FIT module specifying the r_bsp ver.2.90 
For the added r_bsp with ver.2.9 or later, the Warning can be ignored due to backward compatibility. 

 
Figure 4-33 Supplementary: Console Tab 

 
 

 

 

  

Shows the occurrence of Warning.  
Check the contents on Console screen. 
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(d) Code Generation - Summary Dialog Box 

In the Code Generation - Summary dialog box, click the OK button. 

 
Figure 4-34 Code Generation - Summary Dialog Box 

 
 

 

 

  

Click here. 
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4.2 Create an LED Driving Program 
Create a program that toggles the LED0 on/off state every 0.5 seconds using the compare match timer. 

Open the file src/(the project name).c and modify it as shown below.*1 
#include "platform.h" 
#include "r_cmt_rx_if.h" 
 
#define RDP_LED_OFF 1U 
#define RDP_LED_ON 0U 
 
/* Define PODR for LED0. In the case of RSKRX65N-2MB it will be as follows. */ 
/* #define LED0               PORT7.PODR.BIT.B3 */ 
#define RDP_LED0           LED0 
 
/* Define PDR for LED0_PDR. In the case of RSKRX65N-2MB it will be as follows. 
*/ 
/* #define LED0_PDR           PORT7.PDR.BIT.B3 */ 
#define RDP_LED_PDR        LED0_PDR 
 
/* LED Currently status */ 
uint32_t ledstatus = RDP_LED_OFF; 
 
void call_back(void *pdata) 
{ 
 if (ledstatus == RDP_LED_OFF) 
 { 
  /* Turn ON the LED0 If the status is LED_OFF */ 
  RDP_LED0 = RDP_LED_ON; 
  ledstatus = RDP_LED_ON; 
 } 
 else 
 { 
  /* Turn OFF the LED0 If the status is LED_ON */ 
  RDP_LED0 = RDP_LED_OFF; 
  ledstatus = RDP_LED_OFF; 
 } 
} 
 
void main(void) 
{ 
 uint32_t cmt_ch; 
 
 /* LED0 off */ 
 RDP_LED0 = RDP_LED_OFF; 
 /* Create of 0.5 second(2Hz) cyclic timer. */ 
 R_CMT_CreatePeriodic(2, &call_back, &cmt_ch); 
 
 while(1); 
} 

Figure 4-35 Sample program 
Note 1. When using Smart Configurator it is necessary to enter a PODR setting in line 7 and a PDR setting in line 11 to 

match your environment. For details, refer to the user’s manual: Hardware and Circuit diagram of your MCU. 
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4.3 Build and Try Running the Program 
Build the program just created and verify that it runs. 

 
1.  Click Build Project on the Project menu. 

 
Figure 4-36 Build Project 

 
2.  When the build completes, the following will be displayed in Console view. 

 
Figure 4-37 Console View 

  

Click here. 
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3.  Click Debug Build on the Run menu. 

 
Figure 4-38 Debug Configuration 

 

4.  Click  under the Renesas GDB Hardware Debugging and click <project name> HardwareDebug. Click the 
Debugger tab and click Connection Settings. 
Modify EXTAL Frequency to be 24.0000*1 and change Provide Power from Emulator to No*2. 
When these changes have been made, click Debug. 

 

 
Figure 4-39 Debug Configuration 

 
Note 1.  Setting for Renesas Starter Kit+ for RX64M: review is required according to the environment you use. 
Note 2.  This is setting when using an external power supply. When supplying power from the emulator, select Yes. 
  

Click here. 

Modify to 
be 
24.0000*1. 

Click here. 

Modify to be 
No*2. 

Click here. 



RX Family RX Driver Package Ver.1.13 

R01AN3859EJ0113  Rev.1.13  Page 46 of 57 

Oct 20, 2017  

5. When the following message is displayed, click Yes. 

 
Figure 4-40 Confirm Perspective Switch 

 
6. When the load module download completes, a Debug perspective opens. 

 
Figure 4-41 Debug 

  

Click here. 
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7.  Click Restart on the toolbar. The program will be executed and a break will occur at the start of the main function. 

 
Figure 4-42 Restart Program 

 
8. After the break at the start of the main function, click Restart on the tool bar again. 

The project will be run and the program will iterate toggling LED0 with a period of 0.5 seconds. 
 

Click here. 
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5. RX Driver Package Application 

5.1 RX Driver Package Application Structure 
The RX Driver Package Application is a sample application program provided so that users can use the RX Driver 
Package easily. The RX Driver Package Application consists of an application program that operates using device 
drivers and middleware included in the RX Driver Package and a project file for building that application. This allows 
users to start evaluation quickly. 

 

Figure 5-1   RX Driver Package Application Structure 

 
Renesas plans to release a variety of types of this RX Driver Package Application in the future, such as system 
programs that operate using a combination of multiple drivers and middleware and evaluation programs for independent 
modules from the RX Driver Package. 

For information of the latest RX Driver Package Application, refer to the “Products Supporting RX Driver Package 
Application” shown in the following URL. 

 

https://www.renesas.com/rdp 

 

 

Figure 5-2   Types of RX Driver Package Application 

 
 

https://www.renesas.com/rdp
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6. Supplement 

6.1 Commercial Version of Middleware and Drivers Supporting FIT 
A list of the commercial version (paid) Middleware and Drivers for RX Family is shown below. 

For the information of the latest commercial version (paid) Middleware and Drivers, refer to the page of the 
Middleware and Drivers. https://www.renesas.com/mw 

 

Table 6-1   list of the commercial version (paid) Middleware and Drivers for RX Family 

Commercial Version of 
Middleware and Drivers 

URL FIT 
Compliant 

TCP/IP for Embedding 
M3S-T4-Tiny 

https://www.renesas.com/mw/t4 Available 

 

 

6.2 Sample Program 
RX Driver Package is composed of FIT module group in a package, which does not include the sample program for 
operation confirmation. If the sample program is required, download the FIT module unit package separately*1. FIT 
module unit package has “FITDemos” folder an includes sample program or sample project.  

Note 1.  Note that some FIT modules may not provide sample program.  
  

https://www.renesas.com/mw
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6.3 Location of the API Information for FIT Module 
For the API information of FIT module embedded in the project, refer to the doc folder of each FIT module folder. 

 

6.4 Check the RX Driver Package Downloaded 
When successfully downloaded, FIT module is stored in the folder specified in ”FIT Module Folder Path:” described in 
“4.1.1(2)(c)”(Smart Configurator) “4.1.2(2)(a)”(FIT Configurator)(generally, C:\Renesas\e2_studio\ FITModules).  

In “FITModules\Downloaded” folder, ZIP file of the package is stored. 

 

 
Figure 6-1 RX Driver Package 

 

 

 

 

 

 

  

The folder specified in “FIT Module Folder Path:”. 

ZIP file of the package is stored.  
（an_r01an****ej****_rx_fit.zip） 



RX Family RX Driver Package Ver.1.13 

R01AN3859EJ0113  Rev.1.13  Page 51 of 57 

Oct 20, 2017  

6.5 Update FIT Module 
The following describes how to update the FIT module. 

 

6.5.1 Environment Used for the Description 
Upgraded IRQ FIT module Ver.9.99 (r_irq_rx_v9.99) is used as an example.  

 

6.5.2 Add FIT Module 
An intended FIT module is added to the folder specified in “FIT Module Folder Path:”.  

For the file to be stored, ZIP file r_***_v*.**.zip and XML file r_***_v*.**.xml are mandatory, and MDF file 
r_***_v*.**.mdf are mandatory, if they exist. 

 

 
Figure 6-2 Add FIT Module 

 

 

 

  

Add file 

Folder specified in “FIT Module Folder Path:” 
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6.6 Confirm the FIT Module Added in FIT Configurator Screen 
6.6.1 Smart Configurator 
Please restart e2studio. The module is updated to the latest state. 

 

(1) Display additional screen of software component 
1. Select "Component" tab from "led_sample.scfg". 

2. The "Software Component Settings" window will be displayed. Click the "Add Component" button. 

 

 
Figure 6-3 Display addtional screen of software component 

 

  

1.Select components 

2.Click 
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(2) Check the latest FIT module 
1. The latest version is displayed on the software component selection window. 

See “4.1.1(3)” from then on to install the target FIT module. 

 

 
Figure 6-4 Check the latest FIT module 

 

  

Updated IRQ FIT 
module 
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(3) To select old Ver. 
1. If you clear the “Show only last version” check box, the old version will be displayed. 

2. Select the desired version from the list.  

 

 
Figure 6-5 To select old Ver. 

 

  

1.Uncheck 

2.avalavle 
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6.6.2 FIT Configurator 
If FIT Configurator screen is displayed, clear this screen, then, reopen it. The screen information is not updated unless 
reopened. 

(1) Update the screen of FIT Configurator to the latest state 
1. Close the FIT Configurator tab. 

2. Open FIT Configurator from Renesas view. 

 

 
Figure 6-6 Update the screen of FIT Configurator to the latet state 

 

  

1.Close the tab 

2.Open FIT Configurator 
from Renesas Views 
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(2) Check the latest FIT module 
1. Confirm the FIT module added. Latest Ver. will appear on FIT Configurator screen (*).  

See “4.1.2(3)” from then on to install the target FIT module.  

 
Figure 6-7 Check the latest FIT module 

 
(3) To select old Ver. 
1. Pulldown appears by clicking the FIT module Ver. Number. 

2. Click pulldown to show old Ver. 

3. Select the desired version from the pulldown. 

 
Figure 6-8 To select old Ver.  

Updated IRQ FIT 
module Ver.9.99 

1.Click Ver. number  

2.Click here 3.Make settings 
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Website and Support  
Renesas Electronics Website 

http://www.renesas.com/ 
 
Inquiries 

http://www.renesas.com/contact/ 
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General Precautions in the Handling of MPU/MCU Products 
The following usage notes are applicable to all MPU/MCU products from Renesas. For detailed usage notes on the 
products covered by this document, refer to the relevant sections of the document as well as any technical updates that 
have been issued for the products. 

1. Handling of Unused Pins 
Handle unused pins in accord with the directions given under Handling of Unused Pins in the manual. 
 The input pins of CMOS products are generally in the high-impedance state. In operation with an unused pin 

in the open-circuit state, extra electromagnetic noise is induced in the vicinity of LSI, an associated shoot-
through current flows internally, and malfunctions occur due to the false recognition of the pin state as an 
input signal become possible. Unused pins should be handled as described under Handling of Unused Pins in 
the manual. 

2. Processing at Power-on 
The state of the product is undefined at the moment when power is supplied. 
 The states of internal circuits in the LSI are indeterminate and the states of register settings and pins are 

undefined at the moment when power is supplied. 
In a finished product where the reset signal is applied to the external reset pin, the states of pins 
are not guaranteed from the moment when power is supplied until the reset process is completed. 
In a similar way, the states of pins in a product that is reset by an on-chip power-on reset function 
are not guaranteed from the moment when power is supplied until the power reaches the level at 
which resetting has been specified. 

3. Prohibition of Access to Reserved Addresses 
Access to reserved addresses is prohibited. 
 The reserved addresses are provided for the possible future expansion of functions. Do not access these 

addresses; the correct operation of LSI is not guaranteed if they are accessed. 
4. Clock Signals 

After applying a reset, only release the reset line after the operating clock signal has become stable. 
When switching the clock signal during program execution, wait until the target clock signal has 
stabilized. 
 When the clock signal is generated with an external resonator (or from an external oscillator) during a reset, 

ensure that the reset line is only released after full stabilization of the clock signal. Moreover, when 
switching to a clock signal produced with an external resonator (or by an external oscillator) while program 
execution is in progress, wait until the target clock signal is stable. 

5. Differences between Products 
Before changing from one product to another, i.e. to a product with a different type number, confirm 
that the change will not lead to problems. 
 The characteristics of an MPU or MCU in the same group but having a different part number may differ in 

terms of the internal memory capacity, layout pattern, and other factors, which can affect the ranges of 
electrical characteristics, such as characteristic values, operating margins, immunity to noise, and amount of 
radiated noise. When changing to a product with a different part number, implement a system-evaluation test 
for the given product. 



 

  

Notice
1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples.  You are fully responsible for 

the incorporation or any other use of the circuits, software, and information in the design of your product or system.  Renesas Electronics disclaims any and all liability for any losses and damages incurred by 

you or third parties arising from the use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other disputes involving patents, copyrights, or other intellectual property rights of third parties, by or 

arising from the use of Renesas Electronics products or technical information described in this document, including but not limited to, the product data, drawing, chart, program, algorithm, application 

examples.  

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or others.

4. You shall not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part.  Renesas Electronics disclaims any and all liability for any losses or damages 

incurred by you or third parties arising from such alteration, modification, copy or otherwise misappropriation of Renesas Electronics products.

5. Renesas Electronics products are classified according to the following two quality grades: "Standard" and "High Quality".  The intended applications for each Renesas Electronics product depends on the 

product’s quality grade, as indicated below.

 "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic appliances; machine tools; personal electronic 

equipment; and industrial robots etc.

 "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key financial terminal systems; safety control equipment; etc.

 Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems, surgical 

implantations etc.), or may cause serious property damages (space and undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas 

Electronics disclaims any and all liability for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for which the product is not intended by Renesas 

Electronics.

6. When using the Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, "General Notes for Handling and Using Semiconductor Devices" in the 

reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat radiation 

characteristics, installation, etc. Renesas Electronics disclaims any and all liability for any malfunctions or failure or accident arising out of the use of Renesas Electronics products beyond such specified 

ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific characteristics such as the occurrence of failure at a 

certain rate and malfunctions under certain use conditions.  Further, Renesas Electronics products are not subject to radiation resistance design.  Please ensure to implement safety measures to guard them 

against the possibility of bodily injury, injury or damage caused by fire, and social damage in the event of failure or malfunction of Renesas Electronics products, such as safety design for hardware and 

software including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures by your own responsibility as warranty 

for your products/system.  Because the evaluation of microcomputer software alone is very difficult and not practical, please evaluate the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product.  Please investigate applicable laws and 

regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive carefully and sufficiently and use Renesas Electronics products in compliance with all 

these applicable laws and regulations.  Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations.

9. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws 

or regulations. You shall not use Renesas Electronics products or technologies for (1) any purpose relating to the development, design, manufacture, use, stockpiling, etc., of weapons of mass destruction, 

such as nuclear weapons, chemical weapons, or biological weapons, or missiles (including unmanned aerial vehicles (UAVs)) for delivering such weapons, (2) any purpose relating to the development, 

design, manufacture, or use of conventional weapons, or (3) any other purpose of disturbing international peace and security, and you shall not sell, export, lease, transfer, or release Renesas Electronics 

products or technologies to any third party whether directly or indirectly with knowledge or reason to know that the third party or any other party will engage in the activities described above. When exporting, 

selling, transferring, etc., Renesas Electronics products or technologies, you shall comply with any applicable export control laws and regulations promulgated and administered by the governments of the 

countries asserting jurisdiction over the parties or transactions.

10. Please acknowledge and agree that you shall bear all the losses and damages which are incurred from the misuse or violation of the terms and conditions described in this document, including this notice, 

and hold Renesas Electronics harmless, if such misuse or violation results from your resale or making Renesas Electronics products available any third party.

11. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products.

(Note 1)  "Renesas Electronics" as used in this document means Renesas Electronics Corporation and also includes its majority-owned subsidiaries.

(Note 2)  "Renesas Electronics product(s)" means any product developed or manufactured by or for Renesas Electronics.
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